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2019 Optimal Diabetes Care

Preface
Dear Data Submitters,
Attached is our 2019 Optimal Diabetes Care Data Collection Guide. We truly appreciate your medical
group contributing data on quality and patient outcomes. Your involvement is vital to MN Community
Measurement’s ability to achieve our mission to empower health care decision makers with meaningful
data to drive improvement.
We want to support your success as well by providing resources, tools and reports that your medical
group or clinic can use for quality improvement.
The following resources can be found on our corporate website, MNCM.org:
•

•
•
•
•

Public reports including the Health Care Quality Report, Heath Equity of Care Report, Health
Care Disparities Report, Total Cost of Care Report, and topic specific reports released throughout
the year
Patient education and engagement resources
Provider tools and resources
Educational webinars throughout the year
Health Trackers

Additionally, the following resources can be found on the secure MNCM Data Portal:
•
•

Detailed reports and charts of clinical measure results
Charts of specific clinical measure results segmented by race, Hispanic ethnicity, preferred
language and country of origin (REL) for medical groups following best practices

Finally, on MNHealthScores.org, you will find public-facing results of all measures for clinics, medical
groups and hospitals. As this is our consumer-focused site, it has less detail than is available in our
reports and on the Data Portal.
MNCM is committed to working with multi-stakeholder committees to champion the highest value
measures that will make the most impact in our community, while minimizing burden on organizations
that supply the data. And as performance results improve, we have processes in place to retire
measures as appropriate.
Thank you again for your important role in our work. If you have questions, feel free to contact us at
612-746-4522 or support@mncm.org.

Anne Snowden, MPH, CPHQ
Director, Performance Measurement & Reporting
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2019 Optimal Diabetes Care
Summary of Changes
Summary of Changes
A. Measure Specification Changes from Previous Year
1. Eliminated exclusion of documentation that the diagnosis was coded in error.
See Measure Specifications for further detail.

B. Field Specification Changes from Previous Year
1. Language regarding Patient Sex updated for clarity (Column D).
See Data Elements and Field Specifications table for further detail.

C. Other Changes from Previous Year
1. Information about exclusions added to Flow Chart 1 (Measure Specifications).

D. Changes from Draft to Final
1. Correction to data submission start date (cover page). The date was correct in the Process and
Timeline Overview (Preface).
2. Minor edits to Preface cover letter.
3. Removal of instructions to complete Pre-Submission Quality Checklist (Sec III-B-2).
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Measure Specifications
Measure Specifications
Summary of Changes

Eliminated exclusion of documentation that the diagnosis was
coded in error.

Description

The percentage of patients 18-75 years of age who had a diagnosis of type 1
or type 2 diabetes and whose diabetes was optimally managed during the
measurement period as defined by achieving ALL of the following:
• HbA1c less than 8.0 mg/dL
• Blood Pressure less than 140/90 mmHg
• On a statin medication, unless allowed contraindications or exceptions are
present
• Non-tobacco user
• Patient with ischemic vascular disease is on daily aspirin or antiplatelets, unless allowed contraindications or exceptions are
present

Measurement Period

January 1 through December 31, 2018

Eligible Population

Eligible Specialties

Family Medicine, Internal Medicine,
Geriatric Medicine, Endocrinology

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy
(DO), Physician Assistant (PA), Advanced
Practice Registered Nurses (APRN)

Ages

18 years or older at the start of the measurement
period AND less than 76 years at the end of the
measurement period

Diagnosis

Patient had a diagnosis of diabetes (Diabetes Value
Set) with any contact during the current or prior
measurement period OR had diabetes (Diabetes
Value Set) present on an active problem list at any
time during the measurement period.
Both contacts AND the active problem list must be
queried for diagnosis (Diabetes Value Set).

Event

Denominator

At least one established patient office visit
(Established Pt Diabetes & Vasc Value Set)
performed or supervised by an eligible provider in
an eligible specialty for any reason during the
measurement period

The eligible population
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Measure Specifications
Numerator

The number of patients in the denominator whose diabetes was
optimally managed during the measurement period as defined by
achieving ALL of the following:
• The most recent HbA1c in the measurement period has a value less than
8.0 mg/dL
• The most recent Blood Pressure in the measurement period has a
systolic value of less than 140 mmHg AND a diastolic value of less
than 90 mmHg
• On a statin medication, unless allowed contraindications or exceptions are
present
• Patient is not a tobacco user
• Patient with ischemic vascular disease (Ischemic Vascular Disease
Value Set) is on daily aspirin or anti-platelets, unless allowed
contraindications or exceptions are present

Allowable Exclusions

The following exclusions are allowed to be applied to the eligible population:
• Patient was a permanent nursing home resident at any time during the
measurement period
• Patient was in hospice or receiving palliative care at any
time during the measurement period
• Patient died prior to the end of the measurement period
• Patient was pregnant (Diabetes with Pregnancy Value Set) at
any time during measurement period
• Patient had only urgent care visits during the measurement period

Measure Scoring

Rate/Proportion

Interpretation of Score

Higher score indicates better quality

Measure Type

Intermediate Outcome, All-or-none Patient Level Composite
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Measure Specifications
Measure Logic / Flow Charts
Flow Chart 1: Optimal Diabetes Care Measure Patient Flow Chart
Is the patient s DOB between 01/01/1943
and 01/01/2000?
Yes

2019 Optimal Diabetes Care Measure
Patient Flow Chart

Does the patient record have any diagnosis or other
reason which would, per the measure specifications,
exclude the patient from the measure?

No

No

Yes

Required exclusions must be applied to the flow
chart. Allowable exclusions may be applied.

Did the patient have a diagnosis of diabetes (Diabetes
Value Set) with any contact during the current or prior
measurement period (01/01/2017 to 12/31/2018)?

PATIENT NOT
INCLUDED IN
MEASURE

No

Yes

No

Did the patient have a diagnosis of diabetes (Diabetes
Value Set) present on an active problem list at any time
during the current measurement period (01/01/2018
to 12/31/2018)?

No

Yes
Did the patient have at least one established patient
office visit (Established Pt Diabetes & Vasc Value Set)
performed or supervised by an eligible provider in an
eligible specialty for any reason during the
measurement period (01/01/2018 to 12/31/2018)?

Was the patients most recent
HbA1c within the measurement
period less than 8?

Yes

Yes

PATIENT INCLUDED
IN DENOMINATOR

Did the patient s most recent
blood pressure in the
measurement period have a
systolic value of less than 140
mmHg AND a diastolic value of
less than 90 mmHg?

No

No

PATIENT NOT
INCLUDED IN
NUMERATOR

Yes
Is there documentation in the
patient s chart within the last
two measurement periods that
the patient is currently a nontobacco user?
Yes
Is there documentation within
the measurement period that
the patient is on a statin
medication, has a statin use
free pass or a contraindication/
exception to statin use?

See Flow Chart 2 for details.

No

No

No

Yes

Does patient have a diagnosed
comorbidity of IVD (Ischemic
Vascular Disease Value Set)?
Yes

No

Is there documentation within
the measurement period that
the patient is on daily aspirin or
has an accepted
contraindication?
Yes

PATIENT
INCLUDED IN
NUMERATOR
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Measure Specifications
Flow Chart 2: Statin Use Component Flow Chart
2019 Optimal Diabetes Care

On a Statin
during the
measurement
period?

Yes

Statin Use Pass

Statin Use Component
Flow Chart

No

Age 18 to
20?

Yes

Statin Use Free Pass

No

Age 21 to
75?

Yes

Has IVD?
(ASCVD)

Yes

LDL < 40?

No

Contraindications and Exceptions to Statin Use
•
Pregnancy during the measurement period
•
Active liver disease (liver failure, cirrhosis, hepatitis)
•
Rhabdomyolysis
•
End stage renal disease on dialysis
•
Heart failure
•
Breastfeeding during the measurement period
•
Women of child bearing years not actively taking birth control
during the measurement period
•
Allergy to statin
•
Drug interaction with HIV protease inhibitors, nefazodone,
cyclosporine, gemfibrozil, and/or danazol during the
measurement period
•
Intolerance (with supporting documentation of trying a statin at
least once within the last five years)

Contraindications/
Exceptions?

Yes

Statin Use Pass

Yes
Statin Use Free Pass

Statin Use Fail

No

No

Age 21 to
39?

No

Yes

Yes

LDL > 190?

No

Contraindications/
Exceptions?

Yes

No

Statin Use Pass

Statin Use Fail

Statin Use Free Pass

Age 40 to 75

LDL < 70 ?

No

Contraindications/
Exceptions?

Yes

Statin Use Pass

Yes

Statin Use Free Pass
No

Statin Use Fail

LDL < 70, LDL < 40 and LDL > 190
Date of LDL test is within the last five years
Date and value is the most recent within the last five years
(During the measurement year or four years prior)
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Process and Timeline Overview
Process and Timeline Overview
Process Step
Registration
Registration must be completed prior to data submission. Please refer to the
Clinic and Provider Registration Instructions guide available on the Resources
tab of the MNCM Data Portal as well as on MNCM.org for additional
information.
Pre-Submission Data Certification
See Section I for more information.
Data Collection and Submission
See Sections II and III for more information.

Data Validation
See Sections III-B and IV for more information.
Two-Week Medical Group Review Period of Preliminary Statewide Results
See Section IV for more information.
Final Data Results

Important Dates
November 2018 to
February 2019

Submit document by
December21, 2018
MNCM Data Portal is
open for submission
January 7 to February
15, 2019
February and March
2019
April 2019
July 2019

Sharing Data Files and Protected Health Information (PHI) Securely:
It is important that data files and PHI are shared securely between organizations. Email is
not a secure mode of transmitting data.
• Do not send a data file or patient list that contains PHI to MNCM via email.
• Do not include any identifiable patient information in the body of an email message.
o Examples of PHI include (but are not limited to) the following: patient ID, patient
date of birth, patient name, patient address or zip code, insurance member ID, dates
of service.
Please contact support@mncm.org to determine a secure mode of transmission.
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Resources
Data Submission Resources
The Optimal Diabetes Care resources page contains useful documents and answers to Frequently Asked
Questions. To access the resources page:
1. Log in to the MNCM Data Portal.
2. Click on the Resources tab.
3. Select Cycle A – Optimal Diabetes Care from the drop down menu.
a. Download the following documents:
i. Optimal Diabetes Care 2019 Data Collection Guide
ii. Optimal Diabetes Care 2019 Pre-Submission Data Certification Form
iii. Optimal Diabetes Care 2019 Data Collection Spreadsheet Template
iv. Optimal Diabetes Care 2019 Exclusions Template
v. Optional: Optimal Diabetes Care 2019 Data Collection Form. This is a patientlevel form that is most useful for medical groups and clinics using paper records.
vi. 2019 Optimal Diabetes Care Value Set Dictionary. This workbook contains all
Value Sets referenced in this guide.
For questions not answered by the information available on the Resources tab, contact MNCM at
support@mncm.org or 612-746-4522.
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2019 Optimal Diabetes Care
Agreements & Pre-Submission Data Certification

Section I: Agreements and Pre-Submission Data Certification
Clinic and provider registration as well as the electronic signing of the Business Associate Agreement
(BAA), the Direct Data Submission (DDS) Terms and Conditions, and selection of a Data File Transfer
option must be completed prior to data submission.

A. Business Associate Agreement
A business associate is a person or entity that performs certain functions or activities that involve the
use or disclosure of PHI on behalf of, or provides services to, a covered entity. The HIPAA Privacy Rule
requires that a covered entity obtain satisfactory assurances from its business associate that the
business associate will appropriately safeguard the PHI it receives on behalf of the covered entity. Since
MNCM is performing services on behalf of medical groups submitting data that involve the use and
disclosure of PHI, it is necessary for covered entities submitting PHI to MNCM to sign a BAA.
To electronically sign the BAA:
1. Login to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the BAA Agreement link under the Optimal Diabetes Care measure heading.
4. Review the text, click the check box at the bottom of the Agreement and click OK.
a. Once electronically signed, the Agreement applies to all DDS measures and does not
need to be signed again unless provisions of the Agreement change.
b. Failure to electronically sign the Agreement will preclude the medical group from
submitting data.

B. Direct Data Submission Terms and Conditions
Please see Appendix A for detailed information about the DDS Terms and Conditions.
To confirm agreement with the DDS Terms and Conditions:
1. Login to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the DDS Terms & Conditions link under the Optimal Diabetes Care measure heading.
4. Review the text, click the check box at the bottom of the DDS Terms and Conditions and click
Select.
a. Failure to agree to the DDS Terms and Conditions will preclude the medical group from
submitting data for the measure.
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Agreements & Pre-Submission Data Certification
C. Data File Transfer Selection
Beginning in 2014, the Minnesota Department of Health (MDH) has requested the receipt of patient
level data. MDH has assured MNCM that medical groups are permitted to disclose this patient-level data
to MDH under applicable law (including Minnesota law and HIPAA), because it will be used by MDH only
for public health activities, health oversight activities, or other activities required or authorized by state
or federal law. A list of the data elements to be shared with MDH for each measure is available in the
MNCM Data Portal under the Resources tab by selecting Minnesota Statewide Quality Reporting and
Measurement System from the drop-down menu.
MDH will use patient level data to:
•
•
•
•
•
•

Research and analyze health disparities
Design and evaluate public health interventions
Publicly report summary results
Research risk adjustment methodologies
Benchmark and evaluate Health Care Homes
Validate quality measure results

MDH will not use patient level data to pursue investigatory or regulatory activities.
Medical groups must indicate on the MNCM Data Portal whether they choose to allow MNCM to share
patient-level data with MDH.
1. Login to the MNCM Data Portal.
2. Click on Data Files Transfer on the Home tab in the MNCM Data Portal under the Optimal
Diabetes Care section.
3. Choose one of the two data sharing options:
YES – My organization agrees to have MNCM share our patient-level data with MDH for
specified measures.
NO – My organization does not agree to have MNCM share our patient-level data with MDH.
3. Click Save.
If a selection error is made, please contact MNCM at support@mncm.org to request a selection change.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
2

2019 Optimal Diabetes Care
Agreements & Pre-Submission Data Certification
D. Pre-Submission Data Certification
Prior to data collection, medical groups must supply query source code and/or methodology for
identifying the correct eligible patient population. This ensures groups are applying the measure
specifications correctly. A template document is provided in the MNCM Data Portal Resources tab. The
responsibility of applying the measure specifications correctly rests with the medical group.
To download and complete the template and submit it for certification:
1. Login to the MNCM Data Portal.
2. Under the Resources tab, select Cycle A – Optimal Diabetes Care from the drop-down menu.
3. Download the Optimal Diabetes Care Pre-Submission Data Certification Form.
4. Complete and save the form.
5. Login to the MNCM Data Portal and from the Home page click on Denominator Certification
under the Optimal Diabetes Care header. Follow the instructions to upload the saved form to
the MNCM Data Portal.
MNCM will review the information and will either (1) contact the medical group if more clarification is
needed or (2) certify the methodology. An automatic e-mail will notify the medical group when the
method is certified.
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Section II: Data Collection
A. Eligible Population Identification
After Pre-submission Data Certification is complete, medical groups identify the eligible population. This
step must be completed regardless of whether the group plans to submit total population or a sample of
eligible patients. Save all original queries, spreadsheets and other documentation of the process used to
identify the eligible population. This information may be requested during validation.

Preparing the eligible population list:
1. Query applicable systems to identify the eligible population
o Search both patient contacts and problem lists using the value set
2. Remove patients from the list who meet an allowable exclusion (Optional)
o Exclusions with corresponding diagnosis codes/value sets can be identified by
querying the diagnosis associated with encounters.
o Problem lists may also be utilized to identify allowable exclusions but are not
required.
3. De-duplicate the list; include only one record for each patient.
o If a patient is listed more than once within a clinic or medical group, determine
which provider or clinic the patient will be attributed to and delete the other
records/rows within the data file.
o Organizations with more than one registered medical group must report patients
within each medical group for which the patient has met eligibility criteria;
duplication of patients across the organization is possible and expected.
o See Appendix E for the definition of medical group.
4. Review the number of patients in the population and consider whether the number is accurate.
If not, correct the methodology and/or query.

Total Population (recommended)
Per the EMR Reporting Rule established by the Minnesota Department of Health (MDH), clinics that
have had an Electronic Medical Record (EMR) or Electronic Health Record (EHR) in place at any stage for
the last two measurement periods are required to submit data on their total population. MNCM
strongly encourages all clinics to submit data on their total eligible population, when possible. Benefits
include:
•

More reliable performance scores. Performance measurement scores based on total population
data more reliably reflect the quality of care delivered by a clinic and medical group. As the
population size in a data submission increases, the margin of error for reporting differences in
performance narrows.

•

Improved risk adjustment. Risk adjustment is based on the distribution of characteristics within
a clinic’s submitted eligible population. Total population data produces a more reliable
representation of a clinic’s eligible population and increases the number of variables available
for risk adjustment.
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Sample Population
Submission of a sample population for this measure is allowed for clinics that do not have an EMR or
have had an EMR in place for less than two years. See Appendix D for instructions on identifying a
random sample of patients. A sample size of at least 60 records per clinic is required. Clinics with 60 or
less eligible patients must submit data for the total population.

Patient Attribution
To appropriately attribute patients to a provider/clinic, follow the attribution methods described below
in order:
1. First, attribute each patient to the provider and clinic within the medical group that are assigned
to the patient.
2. If the patient does not have an assigned provider or clinic within the medical group, then
attribute the patient to the provider and clinic within the medical group that had the most
encounters with the patient during the measurement period.
3. If multiple providers had an equal number of encounters with the patient, then attribute the
patient to the provider and clinic within the medical group that had the most recent encounter
with the patient during the measurement period.
If a provider has left the clinic/medical group, either attribute the patient to the provider who has left or
to a new provider within the clinic/medical group. Note: the patient must remain in the data file if they
meet eligibility criteria even if their provider no longer works at the clinic.
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B. Data Collection
Data Elements and Field Specifications
Use this section to build your data file for submission. The specifications contain detailed information regarding each column in the submission
file, including column order, definitions, examples, and appropriate formatting.
Summary of Changes

Language regarding Patient Sex updated for clarity (Column D).

Column Field Name

Notes

Excel Format

Example

A

Enter the MNCM Clinic ID of the clinic to which the patient is attributed
based on the attribution methodology detailed in Section II.

Text

9999

Clinic ID

MNCM assigns clinic IDs at the time of registration. Clinic IDs are listed in the MNCM
Data Portal on the Clinics tab. Do NOT use the medical group ID.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that the ID in each cell matches the clinic ID in the MNCM Data
Portal.
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Column Field Name

Notes

Excel Format

Example

B

Enter a unique patient ID to identify each patient.

Text

1

Patient ID

•
•

•

The patient’s medical record number may be used.
Medical groups or clinics that choose not to use the medical record number
should:
o NOT use the patient’s Social Security Number
o Maintain a crosswalk between the patient ID and the medical record
number or patient name and Date of Birth (DOB)
Medical groups or clinics that do not have an EHR should also maintain a
crosswalk between patient ID and patient name and DOB as a tool to locate
records during audit.

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that there are not any duplicate patients. If a patient has
multiple records (rows), determine which clinic the patient should be attributed to
and delete the duplicate record(s). If submitting a sample population, you will need to
replace the deleted record with the next patient listed in the random sample.

C

Patient Date of
Birth

Enter the patient’s date of birth.
The date of birth range for this age group is 01/01/1943 to 01/01/2000.

Date
10/12/1985
(mm/dd/yyyy)

Data Portal Note: A blank field or a value outside of the allowable range will create an
ERROR upon submission.
Quality Check: Verify that the date of birth in each cell is within the accepted range.

D

Patient Sex
CLARIFICATION
for 2019

Enter the patient’s sex:
F = Female

Text
M = Male

U = Unknown/Undefined

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has one of the accepted codes.
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Column Field Name

Notes

Excel Format

Example

E

Enter the five-digit zip code of the patient’s primary residence at the most
recent encounter on or prior to 12/31/2018.

Text

55111

Number

1

Number

2

Text

Country A

Number

1

Text

Language B

Zip
Code_Primary
Residence

If extraction results in a nine-digit zip code, all nine-digits may be submitted. The
MNCM Data Portal will only store the first five digits.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that the zip code is at least five digits and that each cell has a
value.

F
G
H
I
J
K
L

M
N

Race/Ethnicity1
Race/Ethnicity2
Race/Ethnicity3
Race/Ethnicity4
Race/Ethnicity5
Country of Origin
Code
Country of Origin
Other
Description
Preferred
Language Code
Preferred
Language Other
Description

Please refer to a separate document entitled REL Data Elements, Field
Specifications & Codes for Column F-N field definitions and specifications. This
document can be found in the MNCM Data Portal under the Resources tab in
the Race/Ethnicity/Language Data (REL) section, or on MNCM.org under
Submitting Data > Training and Guidance > Data Collection Guides >
Supplemental Specifications.
For more information about collecting this data from patients, refer to the
Handbook on the Collection of Race Ethnicity and Language Data available on
MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides > Supplemental Specifications.
Quality Check: Verify that each cell has one of the accepted codes. Blank cells (if data
is not available) are acceptable.
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Column Field Name

Notes

Excel Format

Example

O

Enter the 10-digit National Provider Identifier (NPI) of the provider to which
the patient is attributed based on the attribution methodology detailed in
Section II.

Text

1234567891

Number

1

Please refer to a separate document entitled Insurance Coverage Data
Elements, Field Specifications & Codes for these field specifications. This
document can be found via the link above, in the MNCM Data Portal under
the Resources tab in the Insurance Coverage Field Specs & Codes for DDS
section, or on MNCM.org under Submitting Data > Training and Guidance >
Data Collection Guides > Supplemental Specifications.

Number

1

Text

WORKERS
COMPENSATION
ONLY

Enter codes corresponding to the patient’s most recent insurance on or prior to
12/31/2018.

Text

FBZXV1234

Provider NPI

If the provider does not have an NPI, enter the provider ID as registered in the MNCM
Data Portal.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has data.

P

Provider
Specialty Code

Enter the specialty code of the physician. If the provider is not a physician,
enter the specialty code of the supervising physician.
1 = Family Medicine
2 = Internal Medicine
5 = Geriatric Medicine

7 = Endocrinology

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.

Q

Insurance
Coverage Code

R

Insurance
Coverage Other
Description

S

Insurance Plan
Member ID

Quality Check: Verify that each cell has an accepted code and that all 99 codes have a
name entered in Column R. Verify that Social Security Numbers are NOT submitted.
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2019 Optimal Diabetes Care
Data Collection
Column Field Name

Notes

Excel Format

Example

T

Enter the code that corresponds to whether the patient has ischemic
vascular disease (IVD).

Number

1

Number

0

Number

2

Patient Has IVD

1 = Yes

0 = No

The Ischemic Vascular Disease Value Set may be utilized but is not the only allowed
method for data collection. Any documentation of a new or existing diagnosis of IVD
during the measurement period or year prior is accepted.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.

U

Patient Has
Depression
OPTIONAL

Enter the code that corresponds to whether the patient had a diagnosis of
depression during the measurement period.
1 = Yes

0 = No

The Major Depression or Dysthymia (DEP-01) Value Set may be utilized but is not the
only allowed method for data collection. Any documentation of a new or existing
diagnosis of depression during the measurement period is accepted.
Quality Check: Verify that each cell has an accepted code.

V

Type 1 or Type 2
Diabetes

Enter the code that corresponds to the patient’s diabetes type (Type 1 or
Type 2 diabetes).
1 = Type 1
2 = Type 2
3 = Not specified or documented
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
10

2019 Optimal Diabetes Care
Data Collection
Column Field Name

Notes

Excel Format

W

Enter the date of the most recent HbA1c test result during the measurement
period.

Date
10/11/2018
(mm/dd/yyyy)

HbA1c Date

•

A test result from a provider outside of the reporting medical group is allowed if
the result is documented in the reporting medical group’s patient record and is
the most recent test result during the measurement period.

•

If the HbA1c result is too high to calculate, still enter the HbA1c test date if it is
the most recent test result during the measurement period.

•

Leave BLANK if an HbA1c test was not performed during the measurement
period.

Example

Data Portal Note: Do NOT enter a test date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are during the measurement period.

X

HbA1c Value

Enter the value of the most recent HbA1c test result during the
measurement period.

Number

Leave field BLANK if an HbA1 test was not performed during the measurement
period, or if the most recent test result was too high to calculate.
Quality Check: Verify that completed cells have valid HbA1c values.
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Data Collection
Column Field Name

Notes

Excel Format

Y

Enter the date of the most recent LDL test result between 01/01/2014 and
12/31/2018.

Date
10/15/2018
(mm/dd/yyyy)

LDL Date

•

A test result from a provider outside of the reporting medical group is allowed if
the result is documented in the reporting medical group’s patient record and is
the most recent test result within the allowable time period.

•

If the LDL result is too high to calculate, still enter the LDL test date if it is the
most recent test result within the allowable time period.

•

LDL values within the last five years will be used to calculate potential exceptions
to being on a statin medication.

•

Leave BLANK if an LDL test was not performed between 01/01/2014 and
12/31/2018.

Example

Data Portal Note: Do NOT enter a test date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are during the allowable time period.

Z

LDL Value

Enter the value of the most recent LDL test result between 01/01/2014 and
12/31/2018.

Number

Leave BLANK if an LDL test was not performed during the allowable time period, or if
the most recent test result was too high to calculate.
Quality Check: Verify that completed cells have valid LDL values.
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Data Collection
Column Field Name

Notes

Excel Format

AA

Enter the date of the most recent blood pressure result during the
measurement period.

Date
10/15/2018
(mm/dd/yyyy)

BP Date

•

A test result from a provider outside of the reporting medical group is allowed if
the result is documented in the reporting medical group’s patient record and is
the most recent test result during the measurement period.

•

Do not include BP readings:

•

o

Taken during an acute inpatient stay or an ED visit.

o

Taken during an outpatient visit which was for the sole purpose of having a
diagnostic test or surgical procedure performed (e.g., sigmoidoscopy,
removal of a mole).

o

Obtained the same day as a major diagnostic or surgical procedure (e.g.,
EKG/ECG, stress test, administration of IV contrast for a radiology procedure,
endoscopy).

o

Reported by or taken by the patient.

Example

Leave BLANK if a blood pressure was not obtained during the measurement
period.

Data Portal Note: Do NOT enter a test date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are during the measurement period.

AB

BP Systolic

Enter the value of the most recent (as defined in Column AA) systolic blood
pressure result during the measurement period.
•

•
•

Number

If more than one value is recorded on the most recent date, the lowest value may
be submitted. It does NOT need to be from the same reading submitted in
Column AC (BP Diastolic).
NOTE: The systolic blood pressure is the upper number in the recorded fraction.
For example, the systolic value for a blood pressure of 124/72 mmHg is 124.
Leave BLANK if a blood pressure was not obtained during the measurement
period.

Quality Check: Verify that completed cells have valid systolic values.
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Data Collection
Column Field Name

Notes

Excel Format

Example

AC

Enter the value of the most recent (as defined in Field AA) diastolic blood
pressure result during the measurement period.

Number

72

Number

1

BP Diastolic

•

•
•

If more than one value is recorded on the most recent date, the lowest value may
be submitted. It does NOT need to be from the same reading as submitted in
Column AB (BP Systolic).
NOTE: The diastolic blood pressure is the lower number in the recorded fraction.
For example, the diastolic value for a blood pressure of 124/72 mmHg is 72.
Leave BLANK if a blood pressure was not obtained during the measurement
period.

Quality Check: Verify that competed cells have valid diastolic values.

AD

Statin
Medication

Enter the code that corresponds to whether the patient was prescribed a
statin medication or if a statin medication was active on the patient’s
medication list during the measurement period.
Please see Appendix B for a list of statin medications.
1 = Yes, patient was prescribed a statin medication, or a statin medication
was indicated as active on the patient’s medication list during the
measurement period.
2 = No, patient was not prescribed a statin medication and a statin
medication was not indicated as active on the patient’s medication list
during the measurement period.
• The following exceptions to statin medication use will be identified by the Data
Portal based on the submitted LDL values (Column Z):
o

Patients with ischemic vascular disease aged 21 to 75 years and an LDL result
less than 40 mg/dL

o

Patients aged 40 – 75 years with an LDL result less than 70 mg/dL

o

Patients aged 21 – 39 years with an LDL less than 190 mg/dL

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.
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2019 Optimal Diabetes Care
Data Collection
Column Field Name

Notes

Excel Format

AE

Enter the date of the most recent statin prescription, order or review on an
active medications list that included a statin during the measurement
period.

Date
10/15/2018
(mm/dd/yyyy)

Statin
Medication
Date

If a statin was not prescribed, ordered, or reviewed as an active medication during
the measurement period (Column AD = 2), leave BLANK.
Data Portal Note: Do NOT enter a date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are during the measurement period.
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Data Collection
Column Field Name

Notes

Excel Format

Example

AF

If the patient was NOT prescribed or did not have a statin medication active
on their medication list during the measurement period (Column AD = 2),
enter the value that corresponds to any of the following contraindications
or exceptions:

Number

1

Statin
Medication
Exception

1 = Pregnancy at any time during the measurement period
2 = Active liver disease (liver failure, cirrhosis, hepatitis)
3 = Rhabdomyolysis
4 = End stage renal disease on dialysis
5 = Heart failure
6 = Other provider documented reason: breastfeeding during the
measurement period
7 = Other provider documented reason: woman of childbearing age not
actively taking birth control during the measurement period
8 = Other provider documented reason: allergy to statin
9 = Drug interaction with a listed medication taken during the measurement
period (valid drug-drug interactions include HIV protease inhibitors,
nefazodone, cyclosporine, gemfibrozil, and danazol).
10 = Other provider documented reason: intolerance (with supporting
documentation of trying a statin at least once within the last five years).
Additionally, Myopathy and Myositis (CHOL-05) Value Set may be used to
document intolerance to statins.
If none of the above contraindications or exceptions are documented, leave BLANK.
NOTE: Items 1 – 5 above can be defined by diagnosis codes that may be used in
data collection. Value Sets include: Pregnancy V/Z Codes (PREG-01), Pregnancy
Diagnosis Codes (PREG-02), Liver Disease (CHOL-01), Rhabdomyolysis (CHOL-02),
ESRD on Dialysis (CHOL-03), and Heart Failure (CHOL-04)
Quality Check: Verify that completed cells have an accepted code.
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Data Collection
Column Field Name

Notes

Excel Format

AG

If the patient has a documented contraindication or exception (Column AF =
1 – 10) enter the date of the contraindication or exception.

Date
10/15/2018
(mm/dd/yyyy)

Statin
Medication
Exception Date

Example

If only the month and year are known, enter the first day of the month.
Data Portal Note: Do NOT enter a date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that completed cells have a valid date.

AH

Aspirin or Antiplatelet
Medication

For patients with Ischemic Vascular Disease (IVD), enter the code that
corresponds to whether the patient is prescribed a daily aspirin product or
antiplatelet medication or if an aspirin product or anti-platelet medication
was active on the patient’s medication list during the measurement period.
Please see Appendix C for methods to identify appropriate aspirin products or
antiplatelet medications.

Number

1 = Yes, patient was prescribed a daily aspirin product or antiplatelet
medication, or one was indicated as active on the patient’s medication list
during the measurement period.
2 = No, patient was not prescribed a daily aspirin product or antiplatelet
medication and one was not indicated as active on the patient’s medication
list during the measurement period.
Aspirin/narcotic combination medications do not qualify as a daily aspirin product.
Quality Check: Verify that each cell has an accepted code.
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2019 Optimal Diabetes Care
Data Collection
Column Field Name

Notes

Excel Format

AI

For patients with IVD, enter the date of the most recent daily aspirin
product or anti-platelet medication prescription, order or review of an
active medication list that included a daily aspirin product or anti-platelet
medication during the measurement period.

Date
10/15/2018
(mm/dd/yyyy)

Aspirin or Antiplatelet
Medication Date

If a daily aspirin product or anti-platelet medication was not prescribed, ordered or
reviewed as an active medication during the measurement period (Column AH = 2),
leave blank
Data Portal Note: Do NOT enter a date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are during the measurement period.
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Data Collection
Column Field Name

Notes

Excel Format

Example

AJ

For patients with IVD who were not prescribed or taking a daily aspirin
product or anti-platelet medication during the measurement period
(Column AH = 2), enter the code that corresponds to any of the following
contraindications or exceptions:

Number

2

Aspirin or Antiplatelet
Medication
Exception

1 = Prescribed anti-coagulant medication during the measurement period
2 = History of gastrointestinal bleeding
3 = History of intracranial bleeding
4 = Bleeding disorder
5 = Other provider documented reason: allergy to aspirin or anti-platelets
6 = Other provider documented reason: use of non-steroidal antiinflammatory agents
7 = Other provider documented reason: documented risk for drug
interaction with a medication taken during the measurement period.
8 = Other provider documented reason: uncontrolled hypertension (systolic
blood pressure greater than 180 mmHg and/or diastolic blood pressure
greater than 110 mmHg)
9 = Other provider documented reason: gastroesophageal reflux disease
(GERD)
If none of the above contraindications or exceptions are documented, leave BLANK
NOTE: Items 2 and 3 above can be defined by diagnosis codes that may be used in
data collection. Value Sets include: GI Bleed (ASA-01) and Intracranial Bleed (ASA-02).

Quality Check: Verify that completed cells have an accepted code.
AK

Aspirin or Antiplatelet
Medication
Exception Date

If the patient has a documented contraindication or exception (Column AJ =
1 - 9) enter the date of the contraindication or exception.

Date
10/15/2018
(mm/dd/yyyy)

If only the month and year are known, enter the first day of the month.
Data Portal Note: Do NOT enter a date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that completed cells have a valid date.
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2019 Optimal Diabetes Care
Data Collection
Column Field Name

Notes

Excel Format

AL

Enter the most recent date that the patient’s tobacco status was
documented during the measurement period or year prior.

Date
10/15/2018
(mm/dd/yyyy)

Tobacco Status
Documentation
Date

Example

If the patient’s tobacco status is not documented or the date of the documentation
cannot be determined, leave BLANK.
Data Portal Note: Do NOT enter a date that occurred in 2019. A date in 2019 will
create an ERROR upon submission.
Quality Check: Verify that entered dates are within the measurement period or year
prior.

AM

Tobacco Status

Enter the code that corresponds to the patient’s most recent tobacco status
during the measurement period or year prior.

Number

1 = Tobacco free (patient does not use tobacco; patient was a former user
and is not a current user)
2 = No documentation
3 = Current tobacco user (tobacco includes any amount of cigarettes, cigars,
pipes or smokeless tobacco)
•
•

If the date of the tobacco status documentation is not documented in the patient
record, enter 2.
E-cigarettes are not considered tobacco products.

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.
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C. Data Quality Checks
MNCM recommends that medical groups complete several quality checks of the data prior to file
upload. Quality checks improve data accuracy, reduce the likelihood of errors, and ensure that the data
can be successfully validated upon audit.
Quality Check 1: File Check
Use Excel’s AutoFilter feature to complete data quality checks of specific data elements in the Excel file.
To set the filter and review specific data elements:
1. Click inside any data cell and activate the AutoFilter by:
a. In Excel 2003, click the Data menu, point to Filter, and then click AutoFilter.
b. In more recent versions of Excel, click the Data tab and in the Sort & Filter area click
Filter.
2. Click on the drop-down boxes of any column and scan for key entry errors, “out-of-range” or
missing data and determine if the data needs to be corrected.
Quality Check 2: Verify Clinical Data
Verify the collected clinical data by reviewing a small sample of records (eight to 10) to compare with
the documentation within the patients’ medical records. If errors are identified, make the corrections in
the data file. Also consider whether the errors were isolated or indicative of a larger data collection
problem.
Quality Check 3: General
Complete the general quality checks outlined below:
1. Complete the quality checks listed in the Notes section of each data element in the Data
Elements and Field Specifications table.
2. Verify that excluded records were removed.
3. Verify that all fields intended to be left blank are indeed blank. Do NOT enter hyphens or zeroes.
4. Remove blank rows at the bottom of the Excel spreadsheet.
a. Press Ctrl/End to go to the bottom-most cell in the spreadsheet. If there are blank rows,
highlight them, right-click in the left margin, and select Delete.
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Section III: Data Submission
A. Data File Creation
Before proceeding with the file submission, be sure to:
• Complete all data collection and data entry.
• Complete data quality checks.
• Combine all clinic files onto one spreadsheet. All clinics in a medical group must be uploaded in
one, single file. The clinic identifier is the Clinic ID.
• Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or
DATE formatting). Columns can be any width.
• Verify that all original columns remain in the spreadsheet even if there is no data in a column.
Do NOT delete any columns.
Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
a. The CSV file will be the data file uploaded to the MNCM Data Portal.
How to create a CSV file from an Excel file:
For Excel 2003 Users
1.
2.
3.

4.
5.
6.
7.
8.

For Excel 2007 Users

For Users of more recent versions
of Excel

Open the original Excel file (.xls).
Activate the worksheet to be uploaded by clicking the worksheet tab.
Click File, Save As.
3. Click the Office Button
3. Click the File tab (upper left(upper left-hand corner of
hand corner of screen);
screen); select Save As.
select Save As.
Navigate to the folder where the file will be saved.
Enter the file name.
At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type
drop-down.
Click Save. The following warning will appear: “…may contain features that are not compatible with
CSV. Do you want to keep the workbook in this format?” Click Yes.
Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV
file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
2. Make changes in the Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
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B. Data Submission
1. Exclusions File Upload
For medical groups that manually collect data, any patient meeting an allowable exclusion must be
tracked on the Optimal Diabetes Care Exclusions Template. This can be downloaded from the MNCM
Data Portal.
Do NOT add columns to the Exclusions Template for reasons that are not allowable
exclusions. Do NOT include patients that are not part of the eligible population.
It is not necessary to convert the Exclusions Template to CSV format prior to upload.
For groups that have an Exclusion Template to upload:
1. Click on Exclusions on the Home tab in the MNCM Data Portal, under the Optimal Diabetes Care
section.
2. Click Browse to search for the Excel file and click Save.
3. Click Submit.
a. If more action is needed prior to submission, click Save as Draft to come back to this
step.
For groups that do not have an Exclusion Template to upload:
1. Click on Exclusions on the Home tab in the MNCM Data Portal, under the Optimal Diabetes Care
section.
2. Click No Exclusions.

2. Data Submission
Click on Data Submission on the Home tab in the MNCM Data Portal under the Optimal Diabetes Care
section. Use the following steps to submit data to MNCM.
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Step 1: Enter Denominator
Using the instructions below, manually enter denominator counts and information or complete and upload a file with this information. Whether
done manually or via a file upload, the information must be completed for each clinic row.
For file upload, begin by clicking Download the Denominator Worksheet. Then follow the steps in the table below to complete the worksheet.
Denominator Entry Field Specifications
Field Name

Denominator Worksheet

Manual Entry

Method Used for
Data Collection

Column C
Enter the code applicable to the
clinic:

Make selection applicable to the clinic
from drop-down menu:

REL Data Collection

1 = EMR: All data pulled via query
2 = Manual: Paper records only
3 = Manual: EMR and paper record
4 = EMR: Some data looked up
manually
5 = EMR: All data looked up manually
Columns D - G
Enter the appropriate code for each
category:

•
•
•
•
•

EMR: All data pulled via query
Manual: Paper records only
Manual: EMR and paper record
EMR: Some data looked up
manually
EMR: All data looked up manually

Check the box under each category for
which best practices were utilized in
the collection of REL data at the clinic.

1 = Yes, this clinic utilizes best
practice
0 = No, this clinic does not utilize best
practice
Number of Patients
that Meet Inclusion
Criteria (Less
Exclusions)

Column H
Enter number of patients attributed
to the clinic who are eligible or who
met the inclusion criteria for the
measure.

Notes

Enter number of patients attributed to
the clinic who are eligible or who met
the inclusion criteria for the measure.

Best practice methods include:
•
Race: Self-Report: Allowing patient to self-report their race and/or
Hispanic ethnicity
•
Race: Reporting Multiple Races: NOT using a multi-racial category,
allowing patients to select more than one race AND using a system that
allows the collection and reporting of more than one race for each
patient
•
Language: Self-Report: Allowing patient to self-report preferred language
•
Country: Self-Report: Allowing patient to self-report country of origin
•
Do NOT include patients who met an accepted exclusion
•
If submitting a sample, the number of eligible patients must be higher
than the Number of Patients Submitting
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Field Name

Denominator Worksheet

Manual Entry

Notes

Number of Patients
Submitting

Column I
Enter the number of patients
attributed to the clinic who are being
submitted

Enter the number of patients
attributed to the clinic who are being
submitted

•

Not Reporting

Columns J & K
Enter the appropriate code in column
J:

Check this box if the clinic is not
reporting any data for this cycle of
data collection.

•

0 = Clinic is reporting
1 = Clinic is NOT reporting

Enter a reason for not reporting in text
box provided (e.g. no patients meet
eligibility criteria).

Number(s) entered must match the count of patients in the data file
o For total population submission, this count must match the
Number of Patients that Meet Inclusion Criteria (Less
Exclusions)
o For a sample submission, this count must be less than the
Number of Patients that Meet Inclusion Criteria (Less
Exclusions)
Please be advised that MNCM’s policy requires ALL clinic sites within a
medical group to submit their data through the DDS process. Likewise,
this is a condition of participation in pay-for-performance programs.

Column K
Enter a reason for not reporting (e.g.
no patients meet eligibility criteria)

If completing the Enter Denominator step via file upload, save the completed file in CSV format (see Section III - A for more information). Click
Browse or Choose File to locate the file and then click Submit File.
Once the information is populated either manually or via file upload, click Save and Continue.
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Step 2: Review & Save
Verify the numbers entered by reviewing all of the clinic site’s information for accuracy (no typos or
duplicate patients). Click Save and Continue or click Back to Step 1 to correct the information.
Step 3: Upload Data
Click Browse or Choose File to search for the CSV file (Figure 1-A) and click Upload CSV and Continue
(Figure 1-B).

A

B

Figure 1
The MNCM Data Portal will scan the CSV file to identify possible errors. The Data Portal will then provide
an upload status that will indicate if there are errors or warnings in the data file. Click on the Refresh link
to view an updated upload status (Figure 2).

Figure 2
To view errors and warnings, click View Errors & Warnings (Figure 3-A).
•

Errors: Corrections must be made and a corrected file uploaded (e.g., date of birth is out-ofrange). Refer to the Data Elements and Field Specifications to review the required data
specifications for each column.
o

Make corrections in the original Excel file and save the corrected file. Then save as a new
CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.
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o

To re-enter the data collection method and/or REL Best Practice status and upload the
corrected file starting from Step 1: Enter Denominator click Clear & Start Over (Figure 3-B).
▪

o
•

Completion of Steps 1, 2 and 3 will be necessary if Clear & Start Over is clicked.

If corrections are only needed to the data file, click Re-Upload Data (csv) file (Figure 3-C).
Begin with Step 3: Upload Data.

Warnings: Closely review these possible errors and decide whether corrections are needed. If
corrections to the data file are necessary, refer to instructions above. If corrections are not
necessary, click Continue to Step 4 (Figure 3-D).

Once the Data (CSV) File has been successfully uploaded to the Data Portal, click Continue to Step 4
(Figure 3-D).

B

Figure 3
Step 4: Review & Submit
1. Review the quality checks for each item listed in the Data Elements and Field Specifications table as
well as the preliminary results and their comparison to the previous measure period’s results to
determine if there are errors in the data.
• To resubmit the data file only, click Re-Upload Data (CSV) File.
• To resubmit the denominator counts and the data file, click Clear & Start Over at the bottom of
the page.
Again, make corrections in the original Excel file and save the corrected file with a new name.
Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the
data.
2. Complete the Data Comparison Notes. This is a required field.
NOTE: If this is the first data submission for this measure or if there have been substantial changes
to the measure itself, there will be no table showing comparison of population and rates to a
previous submission and the Data Comparison Notes text box will not display.
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Review and compare the group and individual clinic results (population and rates) to the prior
submission:
• Number of Patients That Meet Inclusion Criteria (Less Exclusions) – This column contains the
number of patients in the eligible population for the current and previous submission.
• Rates – These columns contain rate results for the current and previous submission.
Using the text box provided, describe reasons for any substantial changes in population or results
from the previous submission. Comments in this field inform MNCM about reasons for the changes
and avoids additional follow-up. After you complete the text box, click Save Notes.
• To complete this step later, click Save as Draft. To access the submission again, click on Data
Submission under the Optimal Diabetes Care section on the Home tab. Contact
support@mncm.org if you need assistance.
3. When the data is ready to submit to MNCM click Submit Data to MNCM.
• The Submit Data to MNCM button will not appear until the Data Comparison Notes step has
been completed as stated above.
Step 5: Done
The data file has been successfully submitted. The MNCM Data Portal will generate an e-mail confirming
receipt.
To download a report of patient level numerator compliance information, click Download Data near the
top of the data comparison section. Columns on the far right of the report indicate which patients were
included in the numerator (1) and which were not (0).
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Section IV: Data Validation
After data is submitted, MNCM completes the following validation of the preliminary results to ensure
accuracy and comparability.
Quality Checks
MNCM completes quality checks of the submitted data. If errors are identified, the medical group must
make corrections to the data file and resubmit.
Validation Audit
All medical groups are subject to an audit. Medical groups selected for an audit are contacted by MNCM.
A list of records for audit will be provided and posted onto the Home page of the Data Portal for the
medical group. Other audit preparations:
• The medical group or clinic site representative must be available to participate in the entire
audit process.
o For data that resides in an electronic record, the audit will be conducted via a HIPAA
secure, online meeting service; the medical group or clinic representative will need to
retrieve and display the selected records and screens necessary to complete the audit.
o For data that resides in a paper record, the audit will take place onsite.
• Patient names or other personal information may be blinded. MNCM will verify date of birth.
• The following items must be available for the audit:
o ALL requested patient records.
o The “crosswalk” between the unique patient identifier and the patient’s name and date
of birth, as necessary.
o Data collection forms and other notes describing where various data elements were
located in the patient record.
o List of patients that were excluded.
NCQA 8 and 30 Audit Process
MNCM utilizes the National Committee for Quality Assurance (NCQA) “8 and 30” process for audits.
• MNCM randomly selects 33 records from each applicable clinic site for validation. At most, 30
records for each clinic site will be reviewed. The additional three records are oversamples to
ensure 30 records will be available on the day of the review.
• The MNCM auditor reviews records one through eight in the sample to verify whether the
submitted data matches the source data in the medical record.
• If no errors are found in these eight records, the compliance rate is 100 percent, and the clinic
site is determined to be in high compliance. The MNCM auditor may determine no further
record review is necessary. The MNCM auditor communicates results to MNCM staff.
• If the auditor identifies one or more errors in these eight records, the auditor will continue
auditing records nine through 30 and a compliance rate is calculated (e.g., 27/30 records
compliant, 90 percent). If the compliance rate is less than 90 percent, the auditor will
communicate the results with MNCM, who will contact the medical group to discuss a corrective
action.
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Two-Week Medical Group Review of the Preliminary Statewide Results
The two-week medical group review is the medical group’s official opportunity to review and comment
on the preliminary statewide results. MNCM will provide a file of the results to all participating medical
groups. Each medical group is responsible for reviewing their own results, investigating any concerns,
and submitting evidence to MNCM if a change in results is requested. MNCM staff will review all
requests and determine an appropriate course of action. A notification about this review will be sent to
the primary data contact and other key contacts registered by the medical group in the MNCM Data
Portal.
After Validation
After MNCM validation is completed, MNCM will approve the data in the MNCM Data Portal. An e-mail
will be sent to the medical group’s data contact notifying them that the data was approved.
After all statewide results are approved, MNCM may publish clinic and medical group level results on
MNHealthScores.org. Results can also be found on the MNCM Data Portal > Results tab.
Medical groups should maintain data submission files and other documents related to data submission
for two years.
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Appendices
Appendix A: About Direct Data Submission
The goal of Direct Data Submission (DDS) is to collect patient-level data from medical groups on specific
health care conditions and publicly report comparable results of health care quality at the clinic site
level. All medical groups follow the same instructions for eligible population identification and data
collection. MNCM certifies methodologies prior to data collection. Then each medical group submits
data to MNCM via a secure, online data portal. As an independent auditor and as a service to each
medical group, MNCM validates the data for accuracy, calculates results from the validated data, and
publicly reports the data on MNHealthScores.org.

Required Reporting
DDS fulfills participation requirements for the Minnesota Department of Health’s Minnesota Statewide
Quality Reporting and Measurement System (SQRMS) as well as other health plan pay-for-performance
programs. In addition, DDS results can be used by medical groups for quality improvement purposes.

DDS Terms and Conditions
To participate in the DDS process, medical groups must agree to:
• MNCM’s DDS Terms and Conditions (signed electronically on the MNCM Data Portal).
• Complete a Business Associate Agreement with MNCM (signed electronically on the MNCM
Data Portal).
• Submit a patient-level file to the secure MNCM Data Portal that automatically calculates results.
• Participate in the data validation process as required by MNCM.
• Have results publicly reported on MNHealthScores.org and in other reports.
• Submit data for ALL clinic sites.
• Submit data in required format (CSV).
• Submit data in good faith.
• Adhere to and follow all data submission timelines and formatting specifications.
Medical groups also understand that:
• MNCM works with corresponding health plans to determine Primary payer type
(Commercial/Private, Medicaid, Medicare, uninsured/self/pay) on your behalf to reduce burden.
• Most Minnesota health plans only accept results generated from the DDS method for their
incentive programs, because the patient-level results can be validated.
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Compliance with Federal and State Regulations
Our legal counsel has assured us that the DDS method complies with applicable provisions of the Health
Insurance Portability and Accountability Act (HIPAA), Health Information Technology for Economic and
Clinical Health (HITECH) Act, and Minnesota statute as long as we are acting as a business associate to
each participating medical group (e.g., by gathering and submitting data on its behalf) and have a signed
BAA with the medical group. The BAA is signed electronically on the MNCM Data Portal. The BAA is
signed once and remains in effect for all DDS measures.

Health Insurance Portability and Accountability Act Law:
•

The activities of data collection, data submission, public reporting and use of results for quality
improvement are considered within the scope of health care operations associated with the
medical group quality improvement efforts.

•

The federal HIPAA law specifically allows release of individually identifiable health information without the consent or authorization of the individual - for treatment, payment and health care
operations of, or for, the provider.

•

MNCM’s business associate agreement includes all provisions required by the HITECH Act.

Minnesota Statute:
•

The primary governing Minnesota statute is MN Stat. Section 144.335.

•

Subd. 3a. entitled "Patient consent to release of records; liability" states: (a) A provider, or a
person who receives health records from a provider, may not release a patient's health records
to a person without a signed and dated consent from the patient or the patient's legally
authorized representative authorizing the release, unless the release is specifically authorized by
law.

•

However, the statute does not restrict release (without patient authorization) to only those
circumstances authorized by state law – the statute also applies to a release authorized by
federal law.

•

Legal counsel assures us that it is reasonable to conclude that the HIPAA privacy regulation does
specifically authorize the release of such information. A covered entity is authorized by HIPAA to
release patient information for, among other things, health care operations and to its business
associate that is providing such health care operations on its behalf. As stated above, the
services MNCM is engaged in with providers falls within the scope of health care operations, and
MNCM is acting as a business associate to the medical groups when performing the services
discussed above.
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Appendix B: Statin Medications
This list is provided for guidance and may not be inclusive of all medications within this therapeutic
class; especially new drugs that have recent FDA approval. Questions about statin medications can be
directed to support@mncm.org.
Table 1: Statin Medications
Generic Name
atorvastatin
fluvastatin sodium
lovastatin
pitavastatin
pravastatin sodium
rosuvastatin calcium
simvastatin
amlodipine besylate and atorvastatin calcium
ezetimibe and simvastatin

Brand / Trade Name
Lipitor
Lescol XL or Lescol
Mevacor, Altocor or Altoprev
Livalo, Zypitamag, Nikita
Pravachol
Crestor
Zocor, FloLipid
Caduet
Vytorin
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Appendix C: Aspirin, Anti-Platelet and Anticoagulant Medications
The intent of the daily aspirin/anti-platelet component of this measure is to reduce cardiovascular risk
for patients with diabetes who have Ischemic Vascular Disease (IVD). Unless contraindicated, taking
daily aspirin or an anti-platelet medication can prevent the formation of clots by reducing platelet
adhesion and reduce the risk of heart attack, stroke or other vascular events.

Aspirin and Aspirin Containing Products
Products containing solely aspirin, any dosage, can be counted as meeting the daily aspirin use measure
component. The following are a few combination products that are also acceptable for the intent of
daily aspirin use:
• Aspirin AND stomach acid reducer (buffered or with proton pump inhibitor)
• Aspirin AND nitrate (chest pain)
• Aspirin AND statin
However, not all products containing an aspirin derivative can be assumed to meet the intent of daily
aspirin use. Most of these combination products would not be taken on a daily basis and should not be
considered daily aspirin use. Many of the combination products are intended to be used on an as
needed basis for control of pain or cold/ flu symptoms. Combination products containing aspirin AND
any of the following are NOT acceptable as meeting the intent of daily aspirin use:
• Acetaminophen
• Caffeine
• Narcotics
• Muscle relaxants
• Decongestants
• Antihistamines
Aspirin products are most frequently obtained over the counter, therefore prescribed is defined by any
of the following: daily aspirin product indicated in the medical record, aspirin product is ordered, aspirin
product is active on the medication list, or aspirin product prescription is given to the patient.

Oral Anti-Platelet Medications
Anti-platelet medications may also be used to meet the intent of daily aspirin use. Like aspirin products,
these medications can prevent the formation of clots by reducing platelet adhesion. This list is provided
for guidance and may not be inclusive of all medications within these therapeutic classes; especially new
drugs that have recent FDA approval. Questions about aspirin, anti-platelet and anticoagulant
medications can be directed to support@mncm.org.
Table 2: Oral Anti-Platelet Medications
aspirin and dipyridamole; Aggrenox®
cilostazol; Pletal®
clopidogrel; Plavix®
dipyridamole; Persantine®

prasugrel; Effient®
ticlopidine; Ticlid®
ticagrelor; Brilinta®
vorapaxar; Zontivity®
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Oral Anti-Coagulant Medications
Anti-coagulant medications, also known as blood-thinners, can frequently be a contraindication to
taking daily aspirin or anti-platelet medication. This, however, is not an absolute contraindication as
some patients on lower doses of warfarin can also safely take daily aspirin. If the patient is indeed taking
daily aspirin in addition to an anti-coagulant, it is acceptable to submit as taking daily aspirin and not
indicate a contraindication/exception. This list is provided for guidance and may not be inclusive of all
medications within this therapeutic class; especially new drugs that have recent FDA approval.
Questions about aspirin, anti-platelet and anticoagulant medications can be directed to
support@mncm.org.
Table 3: Oral Anti-coagulant Medications
apixaban; Eliquis®
betrixaban; Bevyxxa®
dabigatran etexilate; Pradaxa®

edoxaban; Savaysa®
rivaroxaban; Xarelto®
warfarin sodium; Coumadin®, Jantoven®

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
35

2019 Optimal Diabetes Care
Appendices

Appendix D: Sampling Methods
Prior to pulling a random sample of patients, all patients who meet eligibility criteria must first be
identified. Please see Section II for more detailed information about identifying all patients who meet
eligibility criteria. After identifying the eligible population, use Method 1 or 2 to pull a random sample of
patients from the eligible population for each clinic. The patients pulled into the random sample will be
the patients who will be included in the data submission file.
Method 1: Excel Random Number Generator
1. Insert a blank column on the leftmost side of the spreadsheet.
2. Label new column RAND.
3. Place cursor in the first blank cell (A2) and type =RAND().
4. Press enter (a number like 0.793958 will appear).
5. Place the cursor back into this cell; resting over the corner to have
the pointer change to a black cross, double click or drag the formula
down to the last row/patient.
6. Highlight the whole column and click Edit, Copy, Paste Special =
Values to freeze the random number (otherwise it will change with every click on the
spreadsheet).
7. Sort entire eligible population by this new random number.
8. Work down the list row by row, starting with the first row until the number of records in the
sample is met for submission (at least 60 patients per clinic, plus at least 20 oversamples = 80
patients per clinic).
9. If a patient meets one of the accepted exclusions, note this on the exclusions spreadsheet and
keep working down the list. Use oversamples that are after the number of records in the
sample. For example, if 60 records will be submitted and two exclusions were found, include
patient rows 61 and 62 to replace the excluded records.
Method 2: Systematic (Nth Method) Sample Selection
1. Start with a list that has patients sorted by some unique patient related variable.
a. An identifying number like a medical record number or chart number is ideal.
b. Sorting alphabetically is the least desirable in terms of randomness; however, this may
be used when there is no other alternative.
2. Select every Nth patient for the number of patients that will be reported. N should equal the
clinic site’s total eligible population divided by the number of patients that will be submitted (if
needed, round down to the nearest whole number). Highlight or mark every Nth patient on the
list. This is the sample.
a. Example: If a clinic site has 600 eligible patients and 60 patients will be submitted, divide
600/60 = 10. Select every 10th patient on the list.
3. If a patient meets one of the accepted exclusions, note this on the exclusions spreadsheet and
select the next patient on the list (just below the excluded patient).
a. Example: If every 10th patient on the list was selected, and the 1st patient in the sample
(the patient on row 10) has an accepted exclusion reason, select the patient on row 11
to replace the patient that was excluded. Then proceed to the next patient selected for
the sample (patient on row 20).
Missing records: If a record in the sample is not available or missing, do NOT exclude this record. Locate
the record or, if the record cannot be located, include the record and leave the data fields blank.
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Appendix E: Glossary of Terms
Standard list of terms often used in the data submission process. Not all terms apply to all measures.
Allowable Exclusions: Allowable exclusions are optional. A medical group may choose to remove
patients from data submission who meet the criteria described in the Allowable Exclusions section of
the measure specifications.
Assignment: The process by which clinics are assigned to clinical quality measures, for which they are
then responsible to report data to MNCM. Assignments are based on specialties offered at each clinic.
These specialties are selected by the medical group during clinic registration.
Audit: The process by which MNCM reviews and validates the data submitted to ensure the data reflects
the patient record. Audits are completed on-site at a clinic or electronically.
Calculated Exclusions: Exclusions that are calculated by the MNCM Data Portal based on data supplied
in the data file. Patients to whom a calculated exclusion applies must still be included in the data file;
upon submission, the Data Portal will remove the appropriate patients from measure calculation.
Clinic: The individual practice site or sites that are registered under the main medical group. Clinics are
locations where primary or specialty care ambulatory services are provided for a fee by one or more
physicians.
A clinic site location is a building, separate space or an entity with a street address. It should be a
functional unit that is easily understood by patients/consumers. The goal of reporting by clinic site is to
provide patients/consumers with information about the entity with which they are most familiar and to
provide information to clinics that is actionable for quality improvement purposes.
Clinic and Provider Registration: The annual process by which clinics and providers register on the
MNCM Data Portal. Providers who worked at a clinic site during the previous calendar year must be
registered. Typically, this occurs annually during December and January. Please see the Clinic and
Provider Registration Instructions for specific details and guidance.
Clinic ID: Assigned to a clinic by the MNCM Data Portal when the clinic first registers on the MNCM Data
Portal.
Clinical Staff: Defined, for the purposes of Clinic and Provider Registration, as the following provider
types: physicians (MD or DO), advanced practice registered nurses (e.g., Certified Nurse Practitioner,
Certified Nurse Specialist, and Certified Nurse Midwife) and physician assistants (PA).
Contacts Tab: Tab in the MNCM Data Portal that lists all contacts for a particular medical group. Medical
groups can add, remove or edit contact people on this tab. While changes can be made at any time, this
information must be updated by medical groups during Clinic and Provider Registration.
Crosswalk: Process by which a unique identifier is linked to a patient’s name and date of birth so
medical records can be located by clinic staff in the case of an audit by MNCM.
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CSV File: Acronym for “comma separated values.” A CSV file is a common and simple format that is used
to import/transport data between systems or software applications that are not directly related (e.g.,
from a spreadsheet to a database). All data submission files are formatted as CSV files.
Data Collection Form: Form that has all patient-level data elements necessary to collect for measure. It
is optional for medical groups to use this form. It may be most useful for clinics/medical groups using
paper records.
Data Collection Guides: Document providing instructions for clinics/medical groups to submit data
counts or files to the MNCM Data Portal.
Data Comparison: Part of DDS process where clinics/medical groups are asked to review the current
measurement period’s preliminary results for each clinic compared to the last data submission for this
measure and consider any changes between the current period and the prior period. It is expected that
an explanation will be entered into a text box to account for any changes or to indicate that the data
comparison is expected.
Data Elements: Components necessary to submit data files to MNCM and to calculate measure results.
Data File: Excel template supplied on the MNCM Data Portal for DDS data submission. Templates are
specific to and formatted correctly for each measure.
Data File Transfer Selection: MDH has requested the receipt of patient level data. Medical groups must
indicate on the MNCM Data Portal if they chose to allow MNCM to share patient-level data with MDH.
This is called Data File Transfer Selection. Detailed information about the Data File Transfer Selection
options can be found in Section I of the data collection guides.
Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit
patient-level data to MNCM for validation and accurate calculation of results.
Data Quality Checks: MNCM recommends completing several internal quality checks of the data prior to
data file submission. Quality checks improve data accuracy, reduce the likelihood of errors and ensure
the data can be validated upon audit. Please refer to specific data collection guides for guidance on data
quality checks for each measure.
Denominator: The denominator is the bottom number in a fraction. In epidemiology, it represents a
population group at risk of a specific disease. In clinical quality measurement, it is the total number of
patients (or observations) included in the calculated score.
Direct Data Submission (DDS): The DDS method was developed by MNCM to allow medical groups to
submit patient-level data for verification of results. In this process, medical groups upload files of
patient-level clinical data and clinic results are automatically calculated by the MNCM Data Portal.
MNCM validates data submitted through the DDS process before results are publicly reported.
Electronic Medical Record: A digital version of a paper chart that contains all of a patient’s medical
history from one practice, which is also known as EMR or Electronic Health Record (EHR).
Eligible Population: A group of patients who have met all eligibility criteria to be included in a measure.
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EMR Reporting Rule: Established by MDH, clinics that had an EMR in place (at any stage) for the last two
measurement periods are required to submit data on their total population.
Errors: The error and warning report will be displayed after a patient-level data file is submitted via the
MNCM Data Portal. Errors are “hard stops” in the Data Portal (e.g., dates of birth in the file are outside
the date of birth range specified for a measure) that result in the submission of a file not being allowed.
They must be corrected, and a revised patient level data file must be uploaded to the Data Portal before
submission can occur.
Excel Format: Format of Excel template columns necessary to submit data file to MNCM Data Portal.
Excel Template: See Data File.
Exclusions Template: Template available on the MNCM Data Portal for tracking excluded patients. This
document will need to be uploaded to the MNCM Data Portal when the clinical data file is submitted on
measures for which exclusions are tracked. MNCM will review this list and validate a selection of records
during the validation audit. Please read more about the Exclusions Template in Section III.
Field Specifications: The detailed section in the data collection guides that provides instructions and
guidance for the collection of required data elements for measure score calculation.
Final Results: Results calculated by the MNCM Data Portal after submission of a patient level data file
after validation is completed. Final results are displayed on MNHealthScores.org.
Full-Time Equivalent (FTE): The best reflection of the time the provider practiced in a typical work week
at each clinic site over the course of a calendar year. FTE information is submitted during Clinic and
Provider Registration in the provider registration step. Please see the Clinic and Provider Registration
Instructions guide for more information.
Group and Clinic Sites Tabs: These tabs display information about the medical group and clinic sites in
the MNCM Data Portal. Information can be edited for the group or clinic sites as needed.
Home Tab: This tab displays information about all the current measures and deadlines for which the
medical group is responsible.
Hospital-Based Outpatient Clinic Locations: These are included in the physician clinic definition and
must be registered, and report required measures.
Inactive Patients: Patients designated as inactive in a practice management system, billing system or
electronic medical record must be included in the eligible population if they meet measure criteria.
Insurance Coverage Data Elements, Field Specifications and Codes: Document to be used in
conjunction with the data collection guides to accurately collect and report insurance coverage data
elements.
Inter-Rater Reliability (IRR): Recommended to conduct several sample audits with all abstractors for
training purposes if more than one person will abstract data. This ensures measurement specifications
are interpreted consistently and data is collected uniformly.
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Measure Logic/Flow Charts: Used to help illustrate the identification of the eligible population and the
logic of measure calculation.
Measure Specifications: Provide detailed information about each measure, including measure
description, methodology, measurement period, denominator, exclusions and numerator. Located in
the data collection guides that are available on MNCM.org and the MDH website.
Medical Group: The highest level of the MNCM Data Portal clinic and provider registration construct.
The medical group represents a single centralized organization that operates one or more clinic sites.
Organizations define the parameters of the medical group at the time of registration and may choose to
divide clinics operated by the organization into more than one medical group. Medical groups with only
one clinic site must enter information under both the medical group and clinic sections, even though the
information will be the same. When reporting on the clinical quality measures, data for all clinic sites is
submitted to MNCM in one file via the medical group.
Medical Group ID: Assigned to a medical group by MNCM when the medical group first registers on the
MNCM Data Portal.
Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street
address). Medical groups have the option to register a single clinic site or register each specialty as its
own clinic site and then also register a main clinic site. How clinics decide to register depends on how
the clinic desires to have their clinical measures publicly reported on MNHealthScores.org. Please review
the Clinic and Provider Registration Instructions guide for further information about registering multispecialty clinics.
National Provider Identifier (NPI): A unique identifier for individual providers or organizations that
render health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify
themselves in HIPAA standard transactions. Also referred to as Provider ID.
Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the
new clinic must be registered with the medical group and must submit data with the medical group. If
the new clinic uses a different practice management system, billing system or EMR, they should follow
the same instructions and measure specifications to collect the data, and the medical group should
include the new clinic’s data in the data submission to MNCM.
Number of Eligible Patients (Exclusions Removed): Number of patients who are eligible or met the
inclusion criteria for the measure with excluded patients removed for each clinic. This count should be
entered into the MNCM Data Portal during data submission.
Number of Patients Submitting: Number of patients who are eligible and being submitted. This should
be the same number as the as Number of Eligible Patients (Exclusions Removed) if submitting total
population. If submitting a sample population, this is the number of patients in the sample population.
This number must match the number of patients in the data file.
Numerator: The numerator is the top number in a fraction. In epidemiology, it represents the number of
people in a population group who develop the disease of interest. In clinical quality measurement, it is
the number of patients that meet all specified targets of a measure.
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Patient Attribution: A patient is attributed to one clinic and provider that are considered to be
responsible for managing the patient’s care. Please refer to specific data collection guides to review
patient attribution for each measure as it they differ.
Patient-Level Data: Data elements required to calculate measure results. Data is submitted to MNCM
Data Portal via a HIPAA-secure process.
Patient Registries: A tool used by some medical groups to track patient progress and for quality
improvement purposes. MNCM cautions the use of patient registry information for quality measures.
Many registries give a “snapshot” of patients at a given time and would therefore not include all
patients according to established patient criteria or may not reflect the most recent clinical data (e.g.,
most recent blood pressure or labs). Registries that are programmed to update the patient population
and clinical results on a continual basis (24/7) could possibly be used to create data file for submission;
however, please discuss this with MNCM before use. During the validation audit, the MNCM auditor will
use the patient record not the patient registry. If a clinic uses data from a patient registry, the auditor
may find a more recent date/value in the medical record and this would be counted as an error.
Pre-Submission Data Certification: This process is intended to help identify potential data issues prior to
file submission.
Pre-Submission Data Certification Form: Document medical groups complete to outline the method for
identifying the eligible population and other details pertinent to the validation of submitted data.
Preliminary Results: Results calculated by the MNCM Data Portal after submission of a data file but
before results are fully validated.
Primary Data Contact: The person from the medical group who uploads/submits data files for the
clinical quality measures; receives communications from MNCM about data submission and other
important updates; and completes the medical group’s annual registration of the clinics and clinical staff
on the MNCM Data Portal. It is important that the Primary Data Contact information for medical groups
remains up-to-date to ensure MNCM communication is received by the appropriate person in a timely
manner.
Provider File: Excel Template available on the MNCM Data Portal for Clinic and Provider Registration.
This document is uploaded to the MNCM Data Portal during registration.
Provider ID: Created by medical group/clinic for providers who do not have an NPI. This ID will be used
in the data file submission to MNCM.
Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other
countries such as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or
Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist,
Certified Nurse Midwife) are providers that are required to be registered during Clinic and Provider
Registration. Refer to the specific measure specifications for eligible provider types required to report
clinical data for each measure as they differ.
Provider Registration: See Clinic and Provider Registration.
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Provider Specialty Code: Codes generated by MNCM to indicate the board-certified specialty of
providers. The codes are included in the provider registration file and DDS data file. Please see the Clinic
and Provider Registration Instructions guide as well as each data collection guide for further guidance.
Providers Tab: This tab displays all of the information about providers submitted during Clinic and
Provider Registration.
REL: Acronym referring to data elements of race, Hispanic ethnicity, preferred language and country of
origin.
REL Best Practice: Data collection best practice methods for REL data elements include: allowing
patients to self-report race and Hispanic ethnicity, preferred language and country of origin as well as
NOT using a multi-racial category; allowing patients to select more than one race; and using a system
that allows the collection and reporting of more than one race for each patient. For more information
about collecting this data from patients, refer to the Handbook on the Collection of Race Ethnicity and
Language Data available on MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides.
REL Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data
collection guides to accurately collect and report REL data elements.
Required Exclusions: This type of exclusion is required. A medical group must remove patients from
data submission who meet the criteria described in the Required Exclusions section of the Measure
Specifications. These exclusions have evidence that they are clinically appropriate or that the frequency
and impact of the inclusion of these patients would distort the calculated result.
Results Tab: This tab includes final data results and file downloads from prior submission cycles, as well
as charts of current and historical results.
Resources Tab: This tab is organized by topic or measure, and houses data submission guides, tools and
frequently asked questions by measure.
Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report clinic quality
data as one clinic if they meet all of the three following criteria: A) have common ownership; B) have a
majority (more than half) of common clinical staff working across the multiple locations (these clinical
staff must rotate between all of the clinic locations); and C) the total clinical staff across all locations is
no greater than 20 FTEs. Please see clinical staff for further details.
Sample Population: A random selection of patients to be submitted for clinical measures. The sample
population is drawn from the total eligible population. The minimum required sample is 60 patients per
clinic site. See the EMR Reporting Rule to determine eligibility for sample population submission. Not all
measures allow sample population submission. Please see data collection guides for more detailed
instructions.
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Statewide Quality Reporting and Measurement System (SQRMS): State health reform law passed in
2008. Under this law with specific directives within Minnesota Statutes, section 62U.02, all physician
clinics are required to register and submit data on measures to be publicly reported to the
Commissioner of Health. To implement physician clinic registration and the collection of quality
measurement data, MDH developed SQRMS, created through Minnesota Rules, Chapter 4654. MDH has
contracted with MNCM to assist with implementing SQRMS. Under this contract, MNCM supports
physician clinics in meeting registration and measure requirements
Summary of Changes: Area at the beginning of each data collection guide which highlights changes from
the previous year.
System Query: Process by which data elements are pulled from chart system (EMR or manual) by
clinics/medical groups.
Total Population: Consists of the entire eligible population. Please refer to the specific data collection
guides for further instructions on how to submit total population.
Two-Week Review Period: Period after data submission in which clinics/medical groups can review their
preliminary results in comparison with other clinics/medical groups. This is a very important validation
step to ensure accurate results before public reporting.
Urgent Care Clinics: A type of walk-in clinic, either stand-alone or offered as a service of a multispecialty clinic, that primarily treats illness or injuries requiring immediate care, but not serious enough
to require an ER visit. Stand-alone urgent care clinics must register and complete an annual Health
Information Technology (HIT) survey; however, urgent care clinics are not required to report on clinical
quality measures. In terms of the urgent care exclusion, the intent is not to separate acute visits from
non-acute visits in the primary care setting.
Visits to a primary care setting, regardless of the reason for the visit or the scheduling status of the visit
(e.g., walk-in) are to be included. In a multi-specialty clinic setting, patients who have visits from both
the primary care setting and the urgent care setting during the measurement period are to be included.
The urgent care exclusion may be used if the patient is only evaluated at an urgent care visit and not
considered an established patient to allow for care coordination and follow up.
Value Set: A set of administrative codes used to define a concept related to the measure construct (e.g.
denominator, exclusions) using standard coding systems (e.g. ICD-10, CPT, LOINC).
Value Set Dictionary: A spreadsheet-based list of codes by measure. Contains all Value Sets applicable
to a given measure.
Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission.
Warnings should be reviewed to determine if corrections are needed.
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